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Introduction to Interaction Web Portal and Interaction
Marquee

Introduction to Interaction Web Portal

The Interaction Web Portal (IWP) is a web application designed to allow supervisors, managers, executives, end clients of
outsourcers and agents access into the contact center to view reports, recordings, statistics, and allow for live call monitoring of
the agents.

Interaction Web Portal resides in two locations, the CIC server or servers and on a separate IIS server, and thus contains two
installations.The first installation, CIC, exists on the CIC server (or servers).The second installation, the web install of Interaction
Web Portal, exists on a separate IIS server. A third install, IWP LDS Configuration, exists on the web server with the Interaction Web
Portal website.

When installing and configuring Interaction Web Portal, consider the following:
e |WP organizations do not span CIC servers in this release.
IWP supports multiple organizations per CIC server.

°
e Switchover licenses for IWP are included in the switchover license part number.
e Active Directory Lightweight Directory Services, or AD LDS replicas, does not allow for high scalability and redundancy.

Introduction to Interaction Marquee

Interaction Marquee installs with Interaction Web Portal. Interaction Marquee is a statistics delivery and display application. It
provides easy access to near-real-time statistics for multiple workgroups, and even multiple servers by a web browser or other
application. It can display the same data as Interaction Supervisor.

Marquee is often referred to as an alternative to virtual wallboards, replacing small cryptic displays with customizable displays that
users can view in any web browser. Users have complete control over the appearance of their statistics in Marquee.

Marquee has features that go far beyond conventional wallboards. It allows users to send statistics data to other applications,
databases, and hardware interfaces using plug-ins that receive the data and carry out functions based on the design of the plug-in
software.

For more information about configuring and working with Interaction Marquee, see Appendix C: “Interaction Marquee” in this guide.

For more information about using Interaction Marquee, see the Interaction Marquee help.

Reference information

The PureConnect Installation and Configuration Guide contains many references to finding documentation in the PureConnect
Documentation Library.

The PureConnect Documentation Library merges all help systems and documentation installed on the IC Server into a single
searchable unit. The PureConnect Documentation Library enables you to:

e Access the entire documentation set from one location.

e View or search the entire documentation set for a document title, topic, term, or keyword.

You can view the PureConnect Documentation Library at http://help.genesys.com or on the CIC Server from Start...Programs-
>PureConnect ->0nline Documentation->PureConnect Documentation Library, after completing the CIC Server installation.

For product release information see https://help.genesys.com/pureconnect/desktop/pureconnect_product_releases.htm.
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Interaction Web Portal licensing

License and configure users as described in the CIC Installation and Configuration Guide. There are now two license allocation
methods: Assignable and Concurrent. The Assignable license allocation method is continued from previous versions of CIC.

For a single system you can allocate both Assigned and Concurrent licenses. However, all licenses for a specific user must be
allocated as either Assigned or Concurrent. A standard assigned access license is consumed when assigned to the user or station
and released when removed from the user or station. A concurrent access license is consumed when the user logs into the system
and released when the user logs out of the system.

For more information, see:
e Assigned license allocation method
e Concurrent license allocation method

Several licenses are available for Interaction Web Portal:
e Server
e Organization

Agent User

Enterprise User

Scheduled Reports

Note: Interaction Web Portal performs a daily check to identify whether you have exceeded your allowable Organization, Agent,
or Enterprise license.If you exceed the licenses, Interaction Web Portal will log an error message in the Windows Application
Event Log, identifying which licenses are out of compliance, the current number and type of available licenses, and the number
of licenses identified. This event only appears if you exceed licenses, and an event for each license exceeded is generated. For
example, “Total enterprise users have exceeded the total enterprise user license count, licenses: [{}] enterprise user: [{}]".

Server license

This Server License a requirement for each CIC server at a customer site and allows the web portal subsystem to start on an CIC
server and use the server's features. Interaction Web Portal does not run without this license.

Organization license

This counted license dictates the number of organizations created. Multiple organizations can use Interaction Web Portal by
segmenting the CIC server and keeping each organization’s data separate from other organizations.

Depending on your requirements, you may require multiple Organization licenses.For example, an outsourcer with 10 clients who
require access to their recordings, reports, statistics, and live calls, but not data from other organizations would need 10
Organization licenses.

An organization may only need one Organization license.For example, an insurance company whose supervisors require access to
the portal and agents in order to review call recordings only needs one Organization license.

Access licenses

Each user who will have access to Interaction Web Portal must have an access license. IWP has 2 types of access licenses: the
IWP_Supervisor License and the IWP_Agent License.

IWP_Supervisor License

The IWP_Supervisory License is for users who want access to reporting, recordings, statistics and live call monitoring. Not all users
must have access to each feature, but the IWP_Supervisor License allows for access to each of these features and is required for
such access.

IWP_Agent License




An IWP_Agent License provides IWP access to agents in a contact center that would like the ability to listen to their own calls and
review their scorecards. This provides agents a training opportunity to hear how they sound on the call and understand the scores
that they receive.

Marquee license

To enable Interaction Marquee, install the Interaction Web Portal framework and apply this license.

Note: Interaction Web Portal is not required to use Interaction Marquee. You can apply an Interaction Marquee license only;
however, you will not have access to Interaction Web Portal features such as recordings, reports, live call monitoring, and
Interaction Statistics. In addition, systems without the I3_LTENANT_IWP_ORGANIZATION license only have access to
Interaction Marquee functionality.

Scheduled Reports license (optional)

To enable Scheduled Reports, install the Interaction Web Portal framework and apply this license. This license is required only if
you want to run scheduled reports. If this license is enabled, Interaction Web Portal can configure, schedule and download reports.

Assigned license allocation method

The Assignable license method allows you to allocate licenses to specific users.

[ Add user wizard step ¥ - Account information

~N
‘ Account Information

Uiser Mame: if-ﬂzul-‘- J

Password: | saes

Re-enter Password: | seas

) Astive
| Must dhange pasiwed

| Use condurtent icense

Cancel <% Prevsous | Mest = Create

To use assigned licenses, deselect the Use concurrent license check box.

Assignable license acquisition rule

When you allocate an assignable license to a user, the user immediately acquires the license, independent of whether the user is
logged on. If the user logs on to another computer, the user is logged off from the previous computer. Removing the license from
the user or deleting the user releases the acquired Assignable license.




Concurrent license allocation method

Interaction Web Portal uses the concurrent license allocation method. This form of licensing allows you to allocate licenses to
users only and is based on the number of simultaneous users accessing a feature or function. This license method allows users to
acquire available licenses during logon instead of based on configuration.

In the concurrent license model, the license is configured in Interaction Web Portal when you add or edit a User account, but is not
allocated until the user logs on to their application. CIC maintains a list of users, licenses available, and licenses in use.

The concurrent license allocation method offers:
o Flexibility and easier administration.
e Automatic reallocation of licenses based on shift changes.
e Reduction in license counts and management.

I Add wser wizard step 3 - Account information

~

‘ Account Information

User Name: i_F-ntrﬂ-ﬁ

Prssword: |u-|n

Re-grter Passwond:

(TR T Y

il e R

o Amve
| Must change passwond

| Use concument icense

| Cancel | << Previous || Mext >> | Create

To use concurrent licenses, select the Use concurrent license check box.

Concurrent license acquisition rules

The rules for Concurrent license acquisition are:

e A user who logs on to Interaction Web Portal with a license configured as Concurrent acquires a Concurrent license. When the
user logs off, the system releases the acquired Concurrent license. If the user logs on to another machine, the system logs the
user off of the previous machine.

o |If a specific user acquires a license and that license is reacquired for that same user (by any application on any machine), the
previously acquired license is used and the license count does not increase.




Interaction Web Portal requirements

This section describes the software requirements for Interaction Web Portal.

Web server

Refer to CIC System Software Requirements for the latest Web server requirements.
e Microsoft lIS 10

Microsoft IIS 8.5

IIS Media Services (See Download and install IIS Media Services)

Lightweight Directory Services (LDS) Role

Microsoft .NET Framework

Refer to CIC System Software Requirements for the latest Microsoft .NET Framework requirements.

Web browsers

Refer to CIC System Software Requirements for the latest Web browser requirements.

Web browser plug-in

o Silverlight 5 (http://go.microsoft.com/fwlink/?linkid=149156)
Microsoft does not support Silverlight on Windows Server 2019 and later.

Server components

l Note: Running Off Host Session Manager (OSSM) on Interaction Web Portal or Marquee servers is not supported. '

e CIC 2015 R1 or later

o Optional: Interaction Recorder for call recording access. For information on installing and configuring Interaction Recorder, see
the Interaction Recorder Technical Reference located in the PureConnect Documentation Library.

e Optional: Interaction Scheduled Reports for reporting access. For information on installing and configuring Interaction
Scheduled Reports, see the Appendix D: Configure Scheduled Reports for IWP and the C/C Scheduled Reports Installation and
Configuration Guide in the PureConnect Documentation Library.

TCP ports

To ensure proper access to all IWP features, configure TCP ports in your firewall. The ports allow the IWP web server to
communicate to the database and the CIC server.For more information, see Appendix B: Set up TCP Ports for Interaction Web
Portal.

Desktop Experience feature on Windows Server 2016 and Windows Server
2019

You must choose Windows Server (Server with Desktop Experience) when you install Windows Server 2016 and 2019. You cannot
install Server with Desktop Experience after installation.
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Interaction Marquee hardware sizing

Interaction Marquee allows for gathering and aggregating thousands of statistics across multiple CIC servers.This ability presents
challenges when determining the right hardware for your implementation.Consider the example of two companies who are
implementing Interaction Marquee.The first company plans to watch 50,000 statistics, while the second company plans to watch
25,000 statistics. The second company needs more powerful hardware. To help understand why, the following sections provide
insight into the variables involved in determining the right hardware requirements for your implementation.

General hardware guidelines

Understand Marquee variables that impact CPU and memo

Understanding Marquee variables impacting network traffic

Marquee performance best practices

General hardware guidelines

Hardware requirements for a Marquee server vary greatly depending on certain variables. For example, the number of statistics
being shown, the interval at which those statistics are updated, and other considerations. These variables make it impossible to
provide exact sizing guidelines for every usage level. Instead, hardware guidelines for three typical usage levels follow. Choose the
usage level that most closely resembles your own, and use the suggested hardware for that usage level as a point of departure
when sizing your hardware

l Note: The amount of magnetic storage is not a factor in these guidelines.

implementation:
2 cores, 4GB of

Usage level Implementation details
ST e Your implementation of Interaction Marquee is expected to monitor 25,000 statistics or less
hardware e Your average package execution interval is 15 seconds or above. If your execution interval is lower than

15 seconds, your average CPU utilization will increase to the point where additional cores are required
o You have one viewer page per package

implementation:

8 cores, 8GB of
memory

memory With this configuration, Marquee could have an approximate network load of 1Mbps, depending on CIC
server load and number of viewer pages. Most of the 1Mbps should be expected to the Marquee service
process, and only about 20% of traffic going to the package viewer page updates being processed by IIS.
This assumes no more than one viewer page per package is running.

Medium Your implementation of Interaction Marquee is going to monitor between 25,000 and 80,000 statistics

hardware Your average package execution interval is above 10 seconds.

You have less than 50 configured packages

L]
[ ]
[ ]
e You have an average of 2 viewer pages per package

With this configuration, Marquee could have an approximate network load of 4Mbps depending on CIC
server load and number of viewer pages. As the average number of viewer pages per package increases, it
can be expected that a higher percentage of network traffic going towards viewer page updates, nearly 50%

(2Mbps).

Large hardware
implementation:

12+ cores, 12GB
of memory

e Your implementation of Interaction Marquee is expected to watch in excess of 80,000 statistics

e You expect to configure more than 50 packages and have an average execution interval of about 5
seconds

e You have an average of over 2 viewer pages per package
With this configuration, Marquee should expect a network load in excess of 4Mbps, depending on CIC

server load and number of viewer pages. With over 2 active viewer pages per package, it is expected to
exceed 2Mbps percent network utilization handled by the ASP.NET w3wp.exe worker process.




Understand Marquee variables that impact CPU and memory

Interaction Marquee uses four main variables to determine CPU and memory sizing:
Estimated number of statistic packages
Estimated number of unique statistics the server will watch

[ )
e Average package execution interval
e Average number of client’s access per package

Understanding the balance of these four variables will help you determine hardware requirements and when it might be time to
upgrade. Monitoring these variables and the impact they have on performance by using tools like Microsoft Windows Performance
Monitor will you keep your Marquee server running smoothly.

Estimated number of statistic packages

Each statistic package within Interaction Marquee runs a timer at regular intervals. The more executing packages increases CPU
and memory requirements.

Estimated number of unique statistics the server will watch

The number of packages is not the only consideration-the total number of statistics being watched on a given server is also a big
factor.For example, one server might have 100 packages and only watch 1000 total statistics. A second server could have only 10
packages and watch 20,000 statistics. A unique statistic is defined not just as the statistic name but also a specific statistic with a
specific set of parameter values.For example, below are two unique CIC statistic URI's for the same statistic, or two watched
statistic subscriptions.

>ININ.Workgroup_AverageTalkTime?ININ.People.WorkgroupStats W orkgroup=Marketing&ININ.Queue _Interval=CurrentPeriod
ININ.Workgroup_AverageTalkTime?ININ.People.WorkgroupStats_Workgroup=Sales&ININ.Queue_Interval=CurrentPeriod

Marquee only has one statistic subscription if you configure two “like” statistics with the same parameter values.So there is a
difference between the number of statistics configured on an Marquee server versus the number of subscribed statistics.For
example, even though two packages might use these statistics, they are only considered as one subscription for the Marquee
server.

ININ.Workgroup_AverageTalkTime?ININ.People.WorkgroupStats_\Workgroup=Sales&ININ.Queue_Interval=CurrentPeriod
ININ.Workgroup_AverageTalkTime?ININ.People.WorkgroupStats_Workgroup=Sales&ININ.Queue_Interval=CurrentPeriod

Average package execution interval

Each package within Interaction Marquee has an “Interval” at the end, in which it executes (in seconds). The average interval rate at
which packages executes is the factor with highest impact in overall system performance. If this average is low (Marquee has a
lower limit of 3 seconds for this setting) and many packages are configured, average CPU utilization can be high.

Average number of client’s access per package

While Interaction Marquee can be configured with many package types, the most common is the HTML viewer page that can be
viewed in a browser. Any one package can have any number of clients requesting the package results. For example, hundreds of
browsers can access and poll a single statistic package result set. The rate at which a browser will poll the Marquee server for
results is again controlled by the individual package execution interval. If a package is configured with a 5 second interval, each
browser opened to the URL of the viewer page will make a request every 5 seconds. A large number of open viewer pages can flood
a server with requests, driving up CPU usage, disk 10, network traffic, and cause the web server to consume more memory.
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Understanding Marquee variables impacting network traffic

Marquee has five variables that impact its load on network traffic.
The estimated number of unique statistics that a server will watch
The volume of interactions and users on the CIC server

The average package execution interval for your configured statistic packages
The average number of client access per package

The content of developed packages

By understanding these variables, the load Interaction Marquee puts on network resources can be anticipated. Using a tool like
Microsoft Windows Resource Monitor (note: this is different than Windows Performance Monitor) the impact Interaction Marquee
is having on network traffic can be seen and tracked.Windows Resource Monitor allows network activity by process to be
monitored.There are two processes that should be monitored to see the impact Interaction Marquee is having on network
resources.

e ININ.IWP.Marquee.WinService.exe process.This is the main Marquee windows service that executes statistic packages.As
communication with CIC Server(s) increases, the total bytes per second for this process will increase.

e Wa3wp.exe process.This is the Internet Information Services (1IS) worker process that handles requests from statistic package
viewer pages.

Given these two processes make up the total of Interaction Marquees network traffic, the majority of the traffic is generally tied to
the ININ.IWP.Marquee.WinService.exe process.

The estimated number of unique statistics that a server will watch

As the total number of unique statistics being watched increases the total bytes per second will increase for the
ININ.IWP.Marquee.WinService.exe process.The number of statistics by themselves does not present significant load, less than 400
bytes per second per 10,000 configured statistics given an CIC server is idle.It only when combined with the CIC server load and
average execution rate of packages that the network load increases for this process.

The volume of interactions and users on the CIC server

As the volume of interactions and users increases on a CIC server likewise the volume of communication between the Marquee
and CIC increase.As more statistics change values, these statistic updates are communicated to Marquee.By watching the total
bytes per second for the ININ.IWP.Marquee.WinService.exe process changes in volume on the CIC server can be seen and tracked.

The average package execution interval for your configured statistic packages

As already stated the average interval rate at which packages executes is the factor with highest impact in overall system
performance.This can also be seen in the impact it has on network performance.Lower average interval execute rates will cause an
increase in the rate of communication with the CIC server and can be seen in the total bytes per second used by the
ININ.IWP.Marquee.WinService.exe process.In addition the lower increased execute rate will cause more frequent communication
between the running viewer pages.This also increases the total bytes per second for the w3wp.exe process has IIS handles the
additional requests.

The average number of client access per package

As more statistic package viewer pages are opened the increase in the total bytes per second be seen for the 1IS w3wp.exe
process. For example, configure one statistic package using a standard shipping Agent-Status.xslt template using one work group
with 250 users in that workgroup. For everyone one viewer page that is opened to this package approximately 8000 bytes per
second can be seen increased network traffic the w3wp.exe process handles. A higher average number of viewer pages open per
package will change the makeup of Interaction Marquee's total network usage. More traffic will be consumed by the w3wp.exe
process.
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The content of developed packages

Besides the number of executing clients, the content of any given package can impact the total bytes per second the IIS w3wp.exe
process handles. In the above example, approximately 8000 bytes per second was seen with the standard shipping Agent-Status.xslt
template. If a different template was used that will cause a difference in the bytes per second that each open client increases
network load. Any custom package templates developed should be tested to know the impact they have on network resources.

Marquee performance best practices

Follow these best practices to keep your Marquee server healthy.

e Dedicate a server for Interaction Marquee
e Use Windows Performance Monitor after large package changes and from time to time checkups

e KeepPureConnect tracing levels on the marquee server at a default status (41) level

Dedicate a server for Interaction Marquee

Given the significant changes in Marquee performance based on different configurations we suggest that you dedicate a server for
your Marquee implementation. This will allow the web server, the Marquee/IWP web site, and LDAP to run on one server. This
becomes more important for larger scale implementations of Interaction Marquee.

Use Windows Performance Monitor after large package changes and from time to time
checkups

Microsoft Performance Monitor can help you keep track of how your Marquee server is handling its load. You should monitor, CPU,
memory, disk, and Network counters. Additionally you should monitor the ININ.IWP.Marquee.WinService process.

https://technet.microsoft.com/en-us/library/cc749249.aspx

Use Windows Resource Monitor (note: this is different than Windows Performance Monitor) after large package changes and from
time to time checkups to monitor network load. With the use of Windows Resource Monitor you should track the
ININ.IWP.Marquee.WinService.exe and w3wp.exe processes noting changes to the total bytes per second for these processes.

http://blogs.technet.com/b/askperf/archive/2012/02/01/using-resource-monitor-to-troubleshoot-windows-performance-issues-part-
1.aspx

Anytime packages are changed to increase the number of statistics by more than a few thousand statistics consider running
Performance monitor for a period of time to see the impact of package changes. Do this when a few packages are added that have
really low execution intervals. It is also good to run the monitor for a period of time as a checkup on how your Marquee server is
performing.

Keep PureConnect tracing levels on the marquee server at a default status (41) level
Interaction Marquee and IWP support standard tracing provided by PureConnect. Keep these tracing levels at standard shipping
levels unless trying to diagnose or troubleshoot issues.

When properly sized hardware is chosen based on the variables described in this document and best practices are followed
Interaction Marquee can become a power tool in your enterprise.
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Enable and configure IIS and IIS Media Services

Interaction Web Portal uses IIS and its Media Services extension module to stream audio obtained from recordings for use with
playback features. Windows Server 2008 ships a 'Configure Your Server Wizard' to help you properly configure your server in the
desired mode.
This section describes how to:

e Enable IIS for Interaction Web Portal

e Activate Windows Communication Foundation (WCF)

e Download and install IIS Media Services

Enable IIS for Interaction Web Portal

Enable IIS for Windows Server 2012 R2

From the Start menu, select Administrative Tools > Server Manager.
Select Add roles and features from the Dashboard.

Select Next twice.

Select Server Roles.

In the Roles area, select:
-Web Server. Under Web Server select:

o s~ N =

- Common HTTP Feature - Under Common HTTP Feature, select Static Content, Default Document,
Directory Browsing, and HTTP Errors.

- Application Development - Under Application Development, select ASP .NET, .NET Extensibility, ASP,
CGl, ISAPI Extensions, ISAPI Filters, and Server Side Includes.

-Health and Diagnostics - Under Health and Diagnostics select HTTP Logging, and Request Monitor.

- Security - Under Security, select Request Filtering.

-Management Tools. Under Management Tools, select IS Management Console.

13



DESTINATION FERVER

Select server roles Temeau| 2R b com

Bafare You Begin Select one or more roles to install on the selected server.

installation Type Roles Description
AR b [# File and Storage Services (2 of 12 installed) L e 5‘:”"” :'Li“;:;:ﬂ: o
— [] Hypar-v application infrastructure.
reatures [[] Metwork Palicy and Access Senvices
Confirmation [[] Print and Document Services
[ Remote Access

[ Remote Desktop Services
[ Yolume Actrvation Services ]
/ ri f 43 installed)
4 [m] Web Server (T of 34 installed)
- [®] Common HTTE Features (1 of 6 inctalled)
I [w] Health and Diagnostics
b [ Performance
b [E] Security (1 of & installed) =
p [m] Application Development (5 of 11 installed)
b ] FTP Server
[ [W] Management Toals (1 af 7 installed)
[J Windows Deployment Services
[] Windows Server Essentials Expenience
[[] Windows Server Update Services —

L <] (] »

[ <Previous | | Next> [ instal Cancel |

Enable IIS for Windows Server 2016

From the Start menu, select Administrative Tools > Server Manager.
Select Add roles and features from the Dashboard.

Select Next twice.

Select Server Roles.

In the Roles area, select:
-Web Server. Under Web Server select:

a bk wbn =

- Common HTTP Feature - Under Common HTTP Feature, select Static Content, Default Document,
Directory Browsing, and HTTP Errors.

- Application Development - Under Application Development, select ASP .NET, .NET Extensibility, ASP,
CGI, ISAPI Extensions, ISAPI Filters, and Server Side Includes.

-Health and Diagnostics - Under Health and Diagnostics select HTTP Logging, and Request Monitor.

- Security - Under Security, select Request Filtering.

-Management Tools. Under Management Tools, select IS Management Console.

14



fa Add Roles and Features Wizard — | %

DIESTINATION SERVER

Select server roles Temp2016ininib.com

Before You Begin Sebect one or more roles to install on the selected server.

Installation Type Roles Description
SErvEr Selection | Hyper-v Security provides infrastructure for
m [ MultiPoint Services securing the Web server from users
[[] Metwork Policy and Access Services and requests. IIS supports multiple
Features [C] Print and Document Services authentication methods. Pick an
Confimation [] Remote Access appropnate authentication scheme
[] Rermeote Desktop Services based upon the robe of the server.
[] volume Activation Services Filter all incoming requests, rejecting
4 [B] Web Server (IIS) (B of 43 installed) | without processing requests that
4 W] Web Server [T of 34 installed) match user defined values, or restrict
- [W] Common HTTP Features (1 of 6 installed) requests based on onginating
I [ Health and Diagnostics address space.

I [[] Performance
L IR ecurity (1 of 9 installed)
I (W] Application Development (5 of 11 installed]
v [ FTP Server
S Management Tools (1 of 7 installed)
[[] Windows Deployment Services
[] Windows Server Essentials Experience
[ Windows Server Update Services

| < Previous J Next > Instal Cancel

Activate Windows Communication Foundation (WCF)

Activate WCF for Windows Server 2012 R2

From the Start menu, select Administrative Tools > Server Manager.
Select Add roles and features from the Dashboard.

Select Next twice.

Select Features.

In the Features area, expand the:

-.NET Framework 3.5 Features and select HTTP Activation and Non-HTTP Activation.
-.NET Framework 4.5 Features and select WCF Services.

6. Under WCF Services select:

-HTTP Activation

- Messsage Queuing (MSMQ) Activation

-Named Pipe Activation

-TCP Activation

-TCP Port Sharing

o s N =
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DESTINATION SERVER

SE|ECt featu res Temp2012R2 ininlab.com

Select one or more features to install on the selected server,

Before You Begin

Installation Type Features Description
Server Szlection T ST
4 .NET Framework 3.5 Features e TCI? A{jtwaﬁon Suppomf prgcess
Server Roles activation via TCP. Applications that
.NET Framework 3.5 (includes NET 2.0 and 3.0; use TCP Activation can start and
HTTP Activation E stop dynamically in response to
Web Sarver Role (1IS) Mo HTTD Acfreabon work items that arrive over the
| network via TCP.
Role Services 4 [H] NET Framework 4.5 Features (2 of 7 installed)
Confirmation MET Framework 4.5 (Installed)

ASP.MET 4.5

4 [E] WCF Services (1 of 5 installed)
HTTP Activation
Message Queuing (MSMQ) Activation
Mamed Pipe Activation

| CP Activation |
TCP Port Sharing (Installed)
i [] Background Intelligent Transfer Service (BITS)
[ BitLocker Drive Encryption |

<] " | [>]

< Previous | | Mext = | | Install | | Cancel

Activate WCF for Windows Server 2016

From the Start menu, select Administrative Tools > Server Manager.
Select Add roles and features from the Dashboard.

Select Next twice.

Select Features.

In the Features area, expand the:

-.NET Framework 3.5 Features and select HTTP Activation and Non-HTTP Activation.
-.NET Framework 4.6 Features and select WCF Services.

6. Under WCF Services select:

-HTTP Activation

-Messsage Queuing (MSMQ) Activation

-Named Pipe Activation

-TCP Activation

-TCP Port Sharing

a s wn =
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= Add Roles and Features Wizard — O >

DESTINATION SERVER

Se | ect ]C'E E:IJ[U FES Temp201&.ininlab.com

Before You Begin Select one or more features to install on the selected server.

Installation Type Features Description
HEMIE RS ol 4 MNET Framework 3.5 Features o TCF_, ﬁcltil.ratilon sUpports process
Server Roles MNET Framework 3.5 (includes NET 2.0 and 3.0} acinyiviveg 16 F Spphcitivivdhat
HTTP Activation use TCP Activation can start and
s i stop dyramically i response t
Web Server Role (IIS) 4 (W] NET Framework 4.6 Features (2 of 7 installed) work items that arrive over the
— | NET Framework 4.6 (Installed) network via TCP.
: ; ASP.NET 4.6
Confirmation 4 [W] WCF Services (1 of 5 installad)

HTTP Activation
Message Queuing (MSMQ) Activation
MNamed Pipe Activation
CP Activatio
+f| TCP Port Sharing (Installed)
b Background Intelligent Transfer Service (BITS)
[] BitLocker Drive Encryption
[] BitLocker Metwark Unlock
[] BranchCache
[] Client for MFS
[] Containers v

| < Previous | | Next > Install Cancel

Download and install IIS Media Services

Interaction Web Portal uses IIS and its Media Services extension module to stream audio obtained from recordings for use with
playback features. Before you can begin using streaming audio, download and install 1IS Media Services.

Important: To install IIS Media Services on Windows Server 2016 or newer, see PureConnect Customer Care KB article

https://genesyspartner.force.com/customercare/pkb_Home?id=kA40B0000008udFSAQ&.

To download and install IIS Media Services:
1. From Utilities and Downloads, select 1IS Media Services Installation from Microsoft to download the IISMedia64.zip file.
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Install Active Directory Lightweight Directory Services (AD
LDS)

Before you install Interaction Web Portal, first install Active Directory Lightweight Directory Services (AD LDS).The Interaction Web
Portal LDS configurator, which prepares the AD LDS for use with Interaction Web Portal, was placed in the CIC server directory when
you installed CIC.

You can install AD LDS on a Windows Server supported by PureConnect. AD LDS resides in the CIC server directory under
ICServerName\IC_WorkstationPreReqs\IWebPortal.

To install Active Directory Lightweight Directory Services (AD LDS) if you have not previously installed Interaction
Web Portal:

1. Navigate to the ICServerName\IC_WorkstationPreReqs\IWebPortal directory and double-click
ININ.IWP.LdsConfig.exe. The Welcome to the Interaction Web Portal LDS Configurator dialog box appears.

Portal LDS Config oF !m E

Installation Path
Specily whese the LDS data fles should be nstalled.

LS wll shoee ibs database fles in the location specified. Thes ditve should
have at least BGE of frew space and consdesation shoukd be grven for the
refkabiity and perfomance of thes location.

Data Fles Location
|C:\Program Fies\interactive Inteligence\Interaction Wet  Browse.. |

S GENESYS

cBack |[ Met> | conce

2. Click Next. The Installation Path dialog box appears.

F"I Interaction W ortal LDS Con i !m E

Installation Path
Specily whets the LDS data s should be nstaled

LS wall shore its database fbes in the location specified. Thes ditve should
have at least 8GE of free space and considesation shoukd be given for the
reskabdity and pesfomance of thes location.

[ ata Files Location
|E\Progrom Fleshinteractive Inteligencetlnterachon Wit Browse.. I

3 GENESYS

cBock [[ Mew> | concel

3. Inthe Data Files Location field, confirm the location to install LDS data files.To search for a directory, click the Browse
button.
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4. Click Next. The ADAM Instance Type dialog box appears.

6.

3 GENESYS

I Interaction Web Portal LDS Configurator M= E3

LDS Inztance Type
Sedact the LDS mstance type pou want to mnstal

¥ Linique First Instance

This option iz wsed o cieabe the first instance of LDS for a replhcation st
The LDS mstance crzated will be conhigured with thes i
Interaction Wb Portal schema. Use this option for the frst LDS instance
craated,

" Feplca of an Exsting Instance
This option i wed b0 join an eitting LDS rephcaton set. The LDS
invstanis cnesled vall conlan a full copy of the dats in the epcation ssL
“oul will be prompted for the name of an LDS hast in the repheation s2t 1o
joir. Lige Ehes option o the second and subseguent LDG nstances

< Back || Net> | Cancel

S GENESYS

Select the LDS instance type you want to install and click Next. The LDS Credentials dialog box appears.

'-rb'l Interaction Web Portal LDS Configurator

LDS Credentials
Lpacily the credentials to be used for this LDS instance.

Specify & user account bo be wsed for this LDS instance. A doman
account i required for LDS to rephcats with othes LDS instances.
Typicaly the Interaction Web Podal adminizirative domain account is
used IF this nstance will rever be used bo replcate with other LDS
instances. & bocal account may be used.

In the User Name and Password fields, enter the domain name and account credentials for the LDS administrator.
7. Click Next.The Configuration Overview dialog box appears.
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5 Interaction Web Portal LDS Configurator _ [T x|

Configuration Overview
Irestallation & ready bo begin.

= Imstall & unigue indlance of LS and extend schema
= Ingtallation Pathc IC:\Program Fles\intessctve Intelgencetdnbaraction web
+ Senvice Account Identity. APPhadmin

Flease ieview your installation chosces above. [ pwou wankt bo make
changes, chick the Back button now. Ditheswize, chick Instal b bagn
installation and configueation.

S GENESYS
cBock |[ oA | cowe |

Click Install. The Configuration Progress dialog box appears and displays task installation progress check marks as the
installation progresses.

F5 Interaction Web Portal LDS Configurator M= E |
Configuration Progress
~ Tatks

[ 1nstallLDS Instance

[ €xend Schema

[T Creste Local Secuty Group
[ Configure Securiy

S GENESYS

<Bock  |[ owa | Cancel

. When green check marks appear next to each task in the configuration process, click Next.
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5.":-1 Interaction Web Portal LDS Configurator HE E |

Configuration Progress

7~ Tacks

of Inatall LDS Instance

~f ExtendSchema

«f Cieste Local Secuty Group
«f Configure Secuiy

.
< Back II Mead > I Careel I

3 GENESYS

10. When the installation is complete, click Finish.

To install Active Directory Lightweight Directory Services (AD LDS) if Interaction Web Portal is already installed:

1. Navigate to the ICServerName\lIC_WorkstationPreReqs\IWebPortal directory and double-click
ININ.IWP.LdsConfig.exe. The Welcome to the Interaction Web Portal LDS Configurator dialog box appears.

E,-. Interaction Web Portal LDS Configurator HE E

Welcome to the Interaction Web Portal LDS
Configurator

Thiz applcation will guide pou through the sheps bo prepace Actnee Diechony
Lightweight Directory Senvices [LDS] for wse with Intersction 'wieb Portal

Cick Nead bo continus.

ught & 2008 Genesys. All ights reserved,

¢ Beck I I Mead » | Cancel I

S GENESYS

2. Click Next.The Configuration Overview dialog box appears.
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P& Interaction Web Portal LDS Configurator HEE I

Configuration Overview
Iriztallation iz peadi b Begar.

* Update the LDS schems

Please review pour installabon chosces above. IF pou want fo make
changes, chek the Back buttor now. Otherwise, chck Instal to begn

S GENESYS
<Back |[ natat | Cancel |

3. Click Install. The Update Schema dialog box opens.

r:"l Interaction Web Portal LDS Configurator ! E

Configuration Progrezs

7 Tasks

[T updste Sehema

S GENESYS

<Back |[ inamt | Cancel

4. Select the Update Schema check box and click Install.

5. The Configuration Progress dialog box appears and displays a task installation status bar as the installation progresses.
When a green check mark appears next to the Update Schema task in the configuration process, click Next.
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F5 Interaction Web Portal LDS Configurator M= EE |

Configuration Progress
— Tasks

+f Update Schema

I
ook [ Mets | Concel |

3 GENESYS

6. When the installation is complete, click Finish.

.r-q Interaction Web Portal LDS Configuratar -EE

Installation Complete

Congratulations, the local LDS instance is now corfiguned lor use with
Interaction wieb Partal

- 3 GENESYS

& Back I I Finizh I Canoe]
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Install Interaction Web Portal

This section describes installation requirements and instructions for installing Interaction Web Portal. Interaction Web Portal
installation includes a self-signed SSL certificate.All desktop links open https URLs.

Installation requirements

Install Interaction Web Portal

Note:You can still access Interaction Web Portal through an HTTP connection. Best practice recommends you enable the
Required SSL, located in the SSL settings of your web server, to force all Interaction Web Portal server traffic over https. HTTP
is still enabled; therefore, secure your web server.

Installation requirements

Before installing Interaction Web Portal, ensure that:
e |Interaction Center Service is running
Microsoft .NET 3.5 and 4.7 or later framework is installed on the web server
You have the appropriate licenses as described in the Licensing section of this document
Interaction Web Portal LDS (Lightweight Directory Services) is installed
Scheduled Reports Monitor Server is installed

Install Interaction Web Portal

1. If you have not done so already:

a. Download the CIC 2015 R1 or later .iso file from the Product Downloads page at
https://help.genesys.com/pureconnect/secure/Downloads.aspx

b. Copy the .iso file to a file server (non-CIC server) with a high bandwidth connection to the server(s) on which you will be
running the CIC 2015 R1 or later installs.

¢. Mount the .iso file and share the contents to make them accessible to the server(s) on which you will be running the CIC
2015 R1 or later installs.

2. Navigate to the \Installs\Off-ServerComponents directory on the file server.

3. Copy the InteractionWebPortal_2015R1.msi file to the server on which you plan to run this install and double-click to
launch it. The Interaction Web Portal Setup Wizard for CIC 2015 R1 dialog box appears.

4. Click Next. The Custom Setup dialog box appears.
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1‘;— Interaction Web Portal for CIC 2018 R1 Setup

Custom Setup
Select the way you want Feastures to be nstalled,

Click the: icons in the tree below to change the wary Features will be installad,

Interaction Web Portal Interaction Web Portal

This Feature requires
430ME on your hard drive,
Locaticn: C:\Prosgram Fles (xBa)iInteractive Inteligence),
Reset |  Diskusage | Back Next Cancel

5. Confirm the feature requirements are met and the Interaction Web Portal will be installed to the appropriate location and click
Next. The Domain User Validation dialog box appears.

|‘.,,;3- Interaction Web Portal bor CIC 2018 R1 Setup
Domain User Yalidation
Enter the user name, password and domain name.

Flease enter the credentials For a user account with administrative privileges on this
system, This acoount will register components and services bo run in the conbext of

Account speafied.
Password: ||
Dormain l'“pp

6. Inthe User, Password, and Domain fields, type the appropriate credentials for a user account with administrative
permissions.

7. Click Next. The IC Admin account dialog box appears.
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!,;' Interaction ¥Web Portal for CIC 2018 R1 Setup

IC Admin account
Identify & user account.

Specify the user account under which the Inberaction Center service runs. This wil allow
the recorder server to encode recondings for streaming playback on the web sarver.

8. Identify the CIC Administrator account:
a. Inthe User Account field, enter the name of the administrator, or click Browse to search for the appropriate user.
b. Click the arrow at the end of the Domain drop down list and select the CIC domain name.

9. Click Next. The Website Information dialog box appears.

|'; Interaction Web Portal for CIC 2018 B 1 Setup

¥Website Information
Provide the website's name, apphoation and apphcation pool.

WebSite Name: [Det auit web ke =]
Apphcation Name: [P
Application Pool Name: [rar

Bn:lt.lmtlcan:d

10. Click arrow at the end of the WebSite Name drop down list and select a website in which to create a virtual directory. Default
Web Site is selected by default.

11. Click Next.The LDAP Host Credentials dialog box appears.
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|'\;'- Interaction Web Portal for CIC 2018 R1 Setup

LDAP Host Credentials
Specify the credentials wsed to query the LDAP host.

Haost: ||

Prowide & Fully qualified dormain name o IP sddress
User ID: [

Exannphe: DomnainiLizer o LIserBDomain com
User Password: |
Confirm Passward: |
Authentication: |N¢ﬂ0tlﬂl! ﬂ

Back Next Cancel |

12. Inthe Host, User ID, User Password, and Confirm Password fields, enter the LDAP Host credentials.

Note: To prevent potential constraint violations, do not use Localhost host as the host name; provide a fully
qualified domain name (FQDN) or the IP address of the AD Lightweight directory Services (LDS) host. You can enter
multiple LDAP hosts in the Host field, separating each host with a space.Designating multiple hosts prevents portal
failure if one host goes offline.

13. In the Authentication drop-down list, select Negotiate.
14. Click Next. The Interaction Web Portal LDAP Root dialog box appears.

& Interaction Web Portal for CIC 2018 R1 Setup

Interaction Web Portal LDAP Root:
Please provide the path to the desired rook directory,

Look In: 1 Interactive Intelbgence j EI El

_Certificates

_JININ Trace Initiakization
interaction Web Portal
(Dscheduled Reports
Jscheduled Reports Maonitor

IC:\Program Files (=86 )\ Interactive Inteligence)

15. Leave the current settings and click Next.The Ready to install Interaction Web Portal dialog box appears.
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|:;| Interaction ¥eb Portal for CIC 2018 R1 Setup

Ready to install Interaction Web Portal for CIC 2018 R1

Chck: Install bo begin the installation, Chek Back to review or change any of your
installation settings, Chck Cancel ko exit the wizard,

16. Click Install. The Installing Interaction Web Portal dialog box appears. It displays a Status bar and messages as the
installation progresses.

17. When the installation is complete, click Finish in the Completed the Interaction Web Portal Setup Wizard dialog box.
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Interaction Web Portal post-installation tasks

After you complete the installation procedures for Interaction Web Portal, perform post installation tasks, including:
e (Create an Interaction Web Portal Service administrator account
e Configure CIC to play back recordings
o Install Silverlight 5.0 and Configure CIC servers to use IWP under Portal Management IC System
L]

Configure timeout values
e Configure security for Interaction Web Portal

Create an Interaction Web Portal Service administrator account

An Interaction Web Portal Service Administrator account must be created in Interaction Administrator. Assign the Administrator
Role to this account.

Once created, the administrator credentials are set in the Interaction Web Portal Organization Management CIC Server Configuration
page. All connectivity from Interaction Web Portal to the CIC server is established through this account.

When a user runs a custom search for call recordings in Interaction Web Portal, the Service Administrator account is used to check
the security polices and not the user account that runs the search.

Note: Your CIC Administrator should set the Interaction Web Portal Service Administrator account password to never expire by
setting the maximum password age to 0.If an Interaction Web Portal Server Administrator's password expires, users cannot log
on to the portal.

Configure CIC to play back recordings

In CIC, a user can only retrieve recordings if the administrator sets up a policy. To create the policy:
e Add the Desktop Experience feature. Note: If you use Remote Content Servers (RCS), install the Desktop Experience there.

Note: For Windows Server 2016 and 2019, you specify the Server with Desktop Experience option as part of the
Windows Server 2016 and 2019 install. Prior versions of Windows allow you to install this feature post installation.

e Set up the retrieve recordings policy in Interaction Administrator

Add the Desktop Experience feature

Note: For Windows Server 2016 and 2019, you specify the Server with Desktop Experience option as part of the Windows Server
2016 and 2019 install. Prior versions of Windows allow you to install this feature post installation.

1. Open Server Manager and right-click the Features node.

2. Select Add Features from the menu that appears.The Select Features dialog box opens.
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3. Select the Desktop Experience check box. The Add features required for Desktop Experience? dialog box opens.

Adld Fealiares Wizand

Add features requirad for Desktop Expaniance?
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4. Click Add Required Features, and then click Next. The Confirm Installation Selections dialog box opens and displays a
message to restart the server after the system installs the feature.

& Confirm Irstallation Selections
o

Fagtures
_ e it o i Poolmeeog roders, ool ibrvaies, OF Reptures, ok Jrstall.
= T indamatnons s ek
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5. Click Install. The system installs the feature and displays a progress bar showing the status of the installation.
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6. When the installation is complete, the Installation Results dialog box opens and displays a message to restart the server.
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7. Click Close. A message appears, asking if you want to restart the server.

Add Features Wicard

0 D i weank o resbark now?
Thet s ver ot b neskaned bo firksh the installabion

process. You cannot sdd or nemaws otber roles, rok senvices,
or Feaburns untl the serves is restartnd.

[ ] _w |

8. Click Yes to restart the server. When the server restart completes, the Installation Results dialog box reappears with a
summary of results. Optionally click the Print, email, or save the installation report link and then click Close.
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Set up the retrieve recordings policy in Interaction Administrator

1. Openinteraction Administrator, expand the Interaction Recorder node and select Policy Editor.

& Interaction Administrator - [clientlab]

= % | | * ..-" 2

¥ MRCP Servers =] | Poby Edier

g Sesmon Managers Canf g ation
SMS

Jw Probdsm Reporter
5l 2 Inkerackion Tracker
Indrvidiual Types
Crganization Types
iddrass Types
Wuddress Subtypes:

s Tracker Attribute Types

il Tracker Address Types

g Thiss

[ mead-only Data Sources
= 5 Interaction Recceder

&R

i Screen Reconding
S memmte Content Sarves
(= =] Interaction Optimzer
= g Configuration =
Rregater ienss wibi 52 dive [Roma: | Selecedi0 7

2. Inthe right pane, double-click Configuration. The Interaction Recorder Policy Editor window opens.
3. Click the Security tab.
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4. Click the arrow at the end of the Change Policy drop down list and select Edit Policy. The Step 1 Applies to the
following entities dialog box opens.
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e Inthe Name box, type IWP Admin (or another descriptive name for the Interaction Web Portal administrator.
e Inthe Search for Entities, type iwpadmin.

5. Click Next. The Step 2: Select Criteria dialog box opens.
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6. Select the matches the following <workgroup> check box and in the Policy Description area click <workgroup>. The
Select Workgroup dialog box opens.
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7. Inthe Search for workgroups area, type Support and from the drop-down list, select Support and then click OK. The Step
3: Select Actions dialog box opens.
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Remove the check marks from the all check boxes except:

Add bookmarks
Export/archive the recording
Retrieve the recording

View score cards

©

Click Finished and then click Apply. The Re-evaluate security policies dialog box opens.

Re-evaluate securly policies

The secunby policees herve been modfed, which
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10. Select Re-evaluate security for all recordings and then click OK.
11. Close Interaction Recorder Policy Editor and Interaction Administrator.

Install Silverlight 5.0 and Configure CIC servers to use IWP under Portal
Management IC System Configuration

The first time you log on to Interaction Web Portal, download Silverlight 5.0.

l Important: Microsoft does not support Silverlight on Windows Server 2019 and later.

To run Interaction Web Portal and install Silverlight 5.0:
1. Double-click the Interaction Web Portal browser icon on your desktop. The logon dialog box appears.
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6.

7.

8.

Security

() This is a public or shared computer
(I This iz & private compister

Logan

Flease enter your user name and password.

LUisar Mame:
Password:

[Logon ]

3 GENESYS

In the User Name and Password fields, type the LDAP logon credentials created during the LDS installation and click Log on.
The Interaction Web Portal browser appears.

Click Get Microsoft Silverlight. The Do you want to run or save this file? dialog box appears.
Click Run. The system downloads Silverlight.exe. It displays a status bar and messages as the download progresses.
When the download is complete, the Install Silverlight dialog box appears. Click Install Now.

=]
. Install SEMEﬂIght
»
r‘”‘vf | o ol o s e
Mugﬂrs&h- s Siveright updabes .m
SI|VEI’| |g ht Migw Mo Silverbaht Privacy Stateimont

When installation is complete, the system returns to Interaction Web Portal. Click the Portal Management link at the bottom
of the Interaction Web Portal page.

Click the Users drop-down list and select IC Server Configuration. The IC Server Configuration page opens.
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In the LDAP Credentials area, enter the LDAP User and Password credentials and then click Logon.
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Tip: Configure different credentials for LDAP Credentials and the IC server credentials in Step 10. For example, for the
LDAP User credential, enter NTDomain credentials (example: domain\admin.)

9. Inthe IC Servers area, under IC server names select the appropriate CIC server name.
10. InthelC server credentials area, enter the User and Password credentials and click Add.

Tip: Configure different credentials for IC server credentials and the LDAP Credentials in Step 8. For example, for the IC
server User credential, enter iwpadmin.

Note: Each CIC server pair can have only one Interaction Web Portal connection (specifically the LDAP data source for
Interaction Web Portal). CIC does not support multiple Interaction Web Portal servers for one CIC server pair. CIC can
communicate with only one Interaction Web Portal LDAP instance/host. However, multiple CIC servers can connect to
the same Interaction Marquee server (for example, Dev or QA). By adding one server from the CIC server pair to
Interaction Web Portal, both servers can connect to Interaction Web Portal.

If you attempt to add a second server in the same pair, you receive the following message:

The [ServerName] server already has its Interaction Web Portal instance configured to another LDAP server, therefore it
cannot be added. An Interaction Center server can only handle one instance of Interaction Web Portal at one time. Go to
that server and delete the Interaction Web Portal LDAP data source from the IC Data Sources container in Interaction
Administrator. Once that is done the server can then be added.

11. Click Finish. The logon dialog box appears.

12. Inthe User Name and Password fields, type the logon credentials and click Logon. Interaction Web Portal opens and is
successfully installed.

13. To begin creating organizations, adding users, and configuring the application, click the Portal Management link at the
bottom of the page. The IC Server Configuration page opens.

14. Click the IC Server Configuration drop down list and select the area to configure.

l Note: For information on setting up Interaction Web Portal, click the help button. '

Configure timeout values

You can specify the length of time that Interaction Web Portal performs an operation before timing out and returning an error. You
can set a timeout value for searching, loading, and binding. If you do not set a timeout value, Interaction Web Portal uses the default
of:

e 8000 milliseconds for searching (for example, searching for a user, workgroup, or interaction).
e 4000 milliseconds for loading a view or page.
e 4000 milliseconds for binding to the LDAP connection.

You specify the timeout values for Interaction Web Portal by using the Additional Information field in LDAP Data Source
Configuration found in Interaction Administrator. For more information, refer to Interaction Administrator help.

Configure security for Interaction Web Portal

To provide extra security for Interaction Web Portal, you can change the web.config file to:
e Prevent Cross-Frame Scripting attacks.
e Prevent HTTP method overriding.
e Disable debugging.

After a new installation, these changes exist in the web.config file. After you apply an update, you can change the web.config file to
provide extra security.

Prevent cross frame scripting attacks

Add the following content to the web.config file to prevent cross frame scripting attacks:
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<system.webServer>

<httpProtocol>
<customHeaders>
<add name="X-Frame-Options" value="SAMEORIGIN" />
</customHeaders>

</httpProtocol>
...</system.webServer>

Prevent HTTP method overriding

Add the following content to the web.config file to prevent HTTP method overriding:

<system.webServer>

<security>
<requestFiltering>
<denyQueryStringSequences>
<add sequence="_method=PUT" />
<add sequence="_method=POST" />
<add sequence="_method=DELETE" />
</denyQueryStringSequences>
<requestLimits>
<headerLimits>
<add header="X-HTTP-METHOD-OVERRIDE" sizeLimit="0" />
</headerLimits>
</requestLimits>
</requestFiltering>

</security>
...</system.webServer>

Disable debugging

Add the following content to the web.config file to disable debugging:

<system.webServer>

<system.web>

<globalization culture="auto" uiCulture="auto"/>

<compilation debug="false" targetFramework="4.0"/>

</system.web>

</system.webServer>
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Work with Interaction Marquee

Interaction Marquee is a statistics delivery and display application. It provides easy access to near-real-time statistics for multiple workgroups, and even multiple servers by a web
browser or other application. It can display the same data as Interaction Supervisor.

Marquee is available inside the Interaction Web Portal framework and is automatically installed with Interaction Web Portal.

Note: Interaction Web Portal is not required to use Interaction Marquee. You can apply an Interaction Marquee license only; however, you will not have access to Interaction Web
Portal features such as recordings, reports, live call monitoring, and Interaction Statistics. In addition, systems without the I3_TENANT_IWP_ORGANIZATION license only have
access to Interaction Marquee functionality.

Marquee is often referred to as an alternative to virtual wallboards, replacing small cryptic displays with customizable displays that users can view in any web browser. Users have
complete control over the appearance of their statistics in Marquee.

Marquee has features that go far beyond conventional wallboards. It allows users to send statistics data to other applications, databases, and hardware interfaces using plug-ins that
receive the data and carry out functions based on the design of the plug-in software.
In Interaction Marquee, you must:

e Select workgroups and queues to monitor.

e Select the information to display and how to update the display.

o Select where to display the information (such as in a web browser or wallboard device).

This section includes:
e Using Marquee
o Interaction Marquee Packages
e Convert an Interaction Marquee 3.0 package to Interaction Marquee 4
o Update XPath queries
o Create a manifest
Create a ZIP file
o Create a package
o Use alegacy package
e Conversions for Interaction Marquee XML output
o Intervals
o Service Level and Abandoned Rate for a legacy package
o Agent Statistics

Using Marquee

1. Configure Interaction Web Portal Marquee Packager, including selectdata and the format in which to display it.
2. Create Marquee packages that send near-real-time data to the output method you choose.
3. Configure the data output devices (client workstations, wallboards, and so on) to access and display data from the Marquee packages.

I Note: Running Off Host Session Manager (OSSM) on Interaction Web Portal or Marquee servers is not supported.

Interaction Marquee Packages

The following figure shows the Marquee Packager list of packages-the user interface for most package operations:

Statistic Package ] ﬁarm.ee Server Active  Interval (sec) | Status LLast run bime

Tnollu ] iwpwebdemo, app.inin.com | Active 10 Execute succeeded, #/10/2012 5:17:50 PM Edit Delate
wertical [} iwpwebdemo. spp.inin.com | Active L} Exécute succéeded. 8/10/2012 5:17:55 PM Edat Delete
honzontal impwebdemo. app.inin.com  Active i) Execute succeeded. 8/10/2012 5:17:55 PM Edit Delete
details iwpwebdemo.app.inincom Actrve 10 Execute succeeded. 8/10/2012 S:1%:50PM  Edd Delete
status iwpwebdemo, app.inin.com | Active 15 Execute succeeded, #/10/2012 5:17:50 PM Edat Delete

Interaction Marquee license

To enable Interaction Marquee, install the Interaction Web Portal framework and apply the requiredl3_FEATURE_MARQUEE license.

Convert an Interaction Marquee 3.0 package to Interaction Marquee 4.0

Interaction Marquee packages format CIC workgroups or queue data and send it to various output devices. Interaction Marquee 4.0 includes several more viewable statistics, including
statistics for Director, Dialer, and System.
Because adding these statistics updated the XML structure the package feature uses, to use the new statistics, update 3.0 packages to the new Interaction Marquee 4.0 XML format.
To ensure a successful conversion, complete the following:

e Update the XPath queries

e Create a statistics manifest
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Update XPath queries

Update XPath queries in the XSL file to find statistic values from the new XML structure. Use the conversions listed in the "Conversions for Interaction Marquee XML Output" section of
this guide to help convert these values.

For example, if you used the /page/workgroups/workgroup/name XPath to retrieve a workgroup name, change it to the Marquee 4.0 XPath value listed under the Workgroup Name:

/Statistics
/IcServer
/ININ.Workgroup
/ININ.People.WorkgroupStats Workgroup
/@name

You can make similar changes when you work with statistics. For example, if you used the /page /workgroups/workgroup/agentsavailable XPath to get the number of agents
available, now use the following XPath:

/Statistics
/IcServer
/ININ.Workgroup
/ININ.People.WorkgroupStats Workgroup
/ININ.Workgroup AgentsAvailable

Interval structure changed from Interaction Marquee 3.0 to Interaction Marquee 4.0. Now, the name of the interval is an attribute, much like the change to workgroup name. For example,
if you used the following XPath to find a statistic:

/page
/workgroups
/workgroup
/queue
/currentperiod
/averagewaittime

Now, you should use:

/Statistics
/IcServer
/ININ.Workgroup
/ININ.People.WorkgroupStats Workgroup
/ININ.Queue Interval[@name="CurrentPeriod"]
/ININ.Workgroup AverageWaitTime

If you have only one average wait time in your XML output file, you can find the stat without specifying the interval:

/Statistics
/IcServer
/ININ.Workgroup
/ININ.People.WorkgroupStats Workgroup
/ININ.Queue Interval
/ININ.Workgroup AverageWaitTime

Create a manifest
You can create a manifest that specifies the statistics for a package by text, saving time when you create the package. The manifest is an *. ininStatKeys file. Each statistic value
specified in the manifest is on a separate line.

When you select the statistics from an XSL, use the manifest value located in the "Conversions for Interaction Marquee XML Output" section of this document. For example, for Agents
Available, use:

ININ.Workgroup_AgentsAvailable?ININ.People.WorkgroupStats_Workgroup=<SUB>

To create a statistic value for each workgroup you select in a web user interface, it is best practice to use <sus> for the Workgroup value.

To create a value for Average wait Time for All Intervals, use:

ININ.Workgroup AverageWaitTime?ININ.People.WorkgroupStats_ Workgroup=<SUB>&ININ.Queue Interval=<ALL>

For most parameters, to retrieve statistic values use <ALL>. However, to retrieve only average wait time for the current period, use:
ININ.Workgroup AverageWaitTime?ININ.People.WorkgroupStats Workgroup=<SUB>&ININ.Queue Interval=CurrentPeriod

Because service level and abandoned rate have dynamic parameterspecify, specify the value for each parameter and therefore cannot use <ALL> for service level or abandoned rate.
You can, however, still use <sus> to pick up all the workgroups using the specified parameters.

This example shows only calls for current period using the 60-second accumulative histogram interval:

ININ.Workgroup_ServiceLevelDistribution?ININ.People.WorkgroupStats_Workgroup=
<SUB>&ININ.Queues InteractionType=Call&ININ.Queue Interval=CurrentPeriod
&ININ.Queue AccumulativeHistogramInterval=60

Interaction Marquee 4.0 installs HTML. Examples.zip and Reader Board Examples.zip.Use these files as a guide when you create the manifest file. These .zip files are installed
in the Interaction Marquee File Library. To obtain a copy of either package, click View and Download, then click Download. To modify these files and upload a new version, best
practice recommends that you rename them and then select Add Marquee file. For more information, see "About the Examples" in the Interaction Marquee help.

To generate a sample manifest containing all available statistics, see "About Configuration Files" in the Interaction Marquee help. Service level and abandoned rate are not available in
the default sample.

Create a ZIP file

When you create a package, Interaction Marquee 4.0 only reads a manifest if you package it in a .zip file with the XSL or XSLT file. Interaction Marquee locates the manifest by the XSL
name. For example, if your XSL package name is package.xsl, the manifest file must reside at package/package.ininStatKeys. For more information, see “About the
Examples” in the Interaction Marquee 4.0 help.

Create a package

After you create a ZIP file, upload it to the file library and create a package.
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Use a legacy package

If your package does not require the new statistics, you can convert the output into Interaction Marquee 3.0 XML format. This process allows you to continue using the old XSL file.
To convert the output:
1. Create a .zip file of the package and include:

e The <package>.xsl file
e A manifest that includes all the statistics you'll need.

Note: For more information, see “Create a Manifest” and “Create a ZIP file” in this document.If you use the service level or abandoned rate statistics, see “Service Level and
Abandoned Rate for a Legacy Package” in this document.

2. In Interaction Marquee, click the File Library tab and click Add marquee file....

Packages = File library . Viewer Pages

Packages use a number of files of various types to determine which statistics may be P
viewed and to determine the formatting of the statistic data. This file library allows you

to add and delete files that may be used by statistic packages.

Refresh File Library Add marguee file ...

3. Navigate to the .zip package and click Open.
4. Click the Add statistic package button.

& GENESYS 4

[i Marquee -3

3 Add statistic package...

5. InthePackage Wizard window, complete the following:

¢ Inthe Name field, type a package name.
e Optionally modify the Interval in seconds.
e Select the This package is based on a previous version of Marquee check box.

Package Wisard

i Package =

Stefihic packages alom wordmroup setishe dala be be packaged and dudrbuted o other applicatons, databisse, and hardware

interiscome.

Name: | Workgroup Package
Descnpton

Interval: |30 weennds

] Actrrn
| Thix package is based on 3 previcss version of Margues

Checking tha will commer the 4.0 ststistica XNL inbo prewious relessed X381 This aBows you Lo culput wsing
legacy KSL of cutput Srectly to XML,

Cancail | Neat »» |

| Note: When you select this check box, Interaction Marquee 4.0 converts the generated output into XML generated by an Interaction Marquee 3.0 system.

6. Click Next. The Package Wizard displays workgroups from which to obtain statistics for the package.
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| Patkage Wizard

i Package P

Mifguise Servar that should gaderste thil atistic patkaga:
| impotamebd.2p0.inn.com =

Thie Irdorhetssn Center Server 1o pif Statsnies for thes packege:

Avadable: Selected: < sarvers  Cmmrgrave>
rwpelaned appmn,oem § Sepport

| Comesl || asPreviess || et me Create

7. Select at least one workgroup used by the package and click the Add button.
. Click Next. The Package Wizard displays package output type options.
9. Select a package output type, fill in the parameters, and click Next.

©

' Note:For the XSL style sheet, select the XSL file from your ZIP package.

10. Inthe Select a statistic in the grid below to edit its parameters dialog box opens, the statistics needed by your XSL file should be automatically added by your manifest.
Click Next.
Package Wizsrd "
_i Package ]

DL, A e, £

Falect @ stabistic in the grid befow [0 edit ity parsvmelers Add Statiatic
Stazstc name Parametes

o Satistic: Mbaadon Rt Diutritiutioon (1 el .
| Abandsn Rate Cistributiors Workgroop: Support, Drferachon Type: <*"AR" _, Remave ]
Warkgroug ¢ | suppirt
trbersstion Tipe < A cbincta
el ¢ | Curnent Fancd -
Aocumutabsve histogram : | g =

» Sististe Abandon Rate Missed Targes {1 item)
Abanden Rate Mased Taigat Wisfkgrewg: Support, Imedachan Tygd: <""AN" .. Rt

& Siatnbc: Ahandon fate Teget (1 tem)

Abanden Rate Tarpet Workgrieg: SUpport, Inferaction Trpe: <="AF" .., Remat
4 Statistie: Agents avadable {1 ikem)

| Group by itatissc citegory || Groop siatietes by name Statistics=48

Caneel

{ | s Previous || Mestes | smse

11. Optionally add a viewer page and message and click Create. The package will begin sending data.

Package Wizard

i Package P

Tent desonpon of messhis

i date and time: | svz0n2 |5 | 10

o | e gy e

Conversions for Interaction Marquee XML output

This section contains XPath examples for the statistic values found in Marquee 3.0 and their Marquee 4.0 counterparts. It also includes the value to use in your manifest. XML is case-
sensitive, so be sure to use the correct case when dealing with these paths.

Statistic XPath and Manifest Configuration
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Package Name

Marquee 3.0 XPath:/page/name
Marquee 4.0 XPath: /Statistics/PackageName

Package Description

Marquee 3.0 XPath:/page/description
Marquee 4.0 XPath: /Statistics/Description

IC Server Name

Marquee 3.0 XPath: /page/server
Marquee 4.0 XPath: /Statistics/IcServer/@name

Package Creation Time

Marquee 3.0 XPath: /page/created
Marquee 4.0 XPath: /Statistics/Created

Package Message

Marquee 3.0 XPath: /page/adhocmessage
Marquee 4.0 XPath: /Statistics/Message

Workgroup Name

Marquee 3.0 XPath: /page/workgroups/workgroup/name
Marquee 4.0 XPath: /Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/@name

Total Agents

Marquee 3.0 XPath: /page/workgroups/workgroup/agents

Marquee 4.0 XPath: /Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/
ININ.Workgroup_TotalAgents

Manifest: ININ.Workgroup_TotalAgents?ININ.People.WorkgroupStats_Workgroup=<SUB>

Agents Available

Marquee 3.0 XPath: /page/workgroups/workgroup/agentsavailable

Marquee 4.0 XPath: /Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/
ININ.Workgroup _AgentsAvailable

Manifest: ININ.Workgroup_AgentsAvailable?ININ.People.WorkgroupStats_Workgroup=<SUB>

Agents Logged In

Marquee 3.0 XPath: /page/workgroups/workgroup/agentsloggedin

Marquee 4.0 XPath: /Statistics/IcServer/ININ.Workgroup/
ININ.People.WorkgroupStats_Workgroup/ININ.Workgroup_AgentsLoggedin

Manifest: ININ.Workgroup_AgentsLoggedIn?ININ.People.WorkgroupStats_Workgroup= SUB>

Longest Available

Marquee 3.0 XPath: /page/workgroups/workgroup/longestavailable
Marquee 4.0 XPath: /Statistics/IcServer/ININ.Workgroup /ININ.People.WorkgroupStats_Workgroup/ININ.Workgroup_LongestAvailable
Manifest: ININ.Workgroup_LongestAvailable?ININ.People.WorkgroupStats_Workgroup=<SUB>

Longest Outbound ACD Interaction

Marquee 3.0 XPath:/page/workgroups/workgroup/longestoutbound

Marquee 4.0 XPath: /Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/
ININ.Workgroup_LongestOutboundACDInteraction

Manifest:ININ.Workgroup_LongestOutboundACDInteraction?ININ.People.
WorkgroupStats_Workgroup=<SUB>

Longest Inbound ACD Interaction

Marquee 3.0 XPath:/page/workgroups/workgroup/longestinbound

Marquee 4.0 XPath:/Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/
ININ.Workgroup_LongestinboundACDInteraction

Manifest:ININ.Workgroup_LongestinboundACDInteraction?ININ.People.WorkgroupStats_Workgroup=
<SUB>

Longest Non-ACD Interaction

Marquee 3.0 XPath:/page/workgroups/workgroup/longestnonacd

Marquee 4.0 XPath:/Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/
ININ.Workgroup_LongestNonACDInteraction

Manifest:ININ.Workgroup_LongestNonACDInteraction?ININ.People.WorkgroupStats_Workgroup=
<SuB>

Number on Inbound ACD
Interactions

Marquee 3.0 XPath:/page/workgroups/workgroup/numberoninbound

Marquee 4.0 XPath:/Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/
ININ.Workgroup_OninboundACDInteractions

Manifest:ININ.Workgroup_OninboundACDInteractions?ININ.People.WorkgroupStats_Workgroup=<SUB>

Number on Inbound ACW

Marquee 3.0 XPath:/page/workgroups/workgroup/numberoninboundinacw
Marquee 4.0 XPath:/Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/ ININ.Workgroup_OnInboundACW
Manifest:ININ.Workgroup_OninboundACW?ININ.People.WorkgroupStats_Workgroup=<SUB>

Number on Outbound ACD
Interactions

Marquee 3.0 XPath:/page/workgroups/workgroup/numberonoutbound

Marquee 4.0 XPath:/Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/
ININ.Workgroup_OnOutboundACDInteractions

Manifest:ININ.Workgroup_OnOutboundACDInteractions?ININ.People.WorkgroupStats_Workgroup=
<SUB>

Number on Outbound ACW

Marquee 3.0 XPath:/page/workgroups/workgroup/numberonoutboundinacw
Marquee 4.0 XPath:/Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/ ININ.Workgroup_OnOutboundACW
Manifest:ININ.Workgroup_OnOutboundACW?ININ.People.WorkgroupStats_Workgroup= <SUB>
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Interactions Answered Marquee 3.0 XPath:/page/workgroups/workgroup/callsanswered

Marquee 4.0 XPath:/Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/
ININ.Workgroup_InteractionsConnected

Manifest:ININ.Workgroup_InteractionsConnected?ININ.People.WorkgroupStats_Workgroup= <SUB>

Interactions Waiting Marquee 3.0 XPath:/page/workgroups/workgroup/callswaiting
Marquee 4.0 XPath:/Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/ ININ.Workgroup_InteractionsWaiting
Manifest:ININ.Workgroup_InteractionsWaiting?ININ.People.WorkgroupStats_Workgroup= <SUB>

Longest Talk Time Marquee 3.0 XPath:/page/workgroups/workgroup/longesttalktime
Marquee 4.0 XPath:/Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/ ININ.Workgroup_LongestTalkTime
Manifest:ININ.Workgroup_LongestTalkTime?ININ.People.WorkgroupStats_Workgroup= <SUB>

Longest Wait Time Marquee 3.0 XPath:/page/workgroups/workgroup/longestwaiting
Marquee 4.0 XPath:/Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/ ININ.Workgroup_LongestWaitTime

Manifest:ININ.Workgroup_LongestWaitTime?ININ.People.WorkgroupStats_Workgroup= <SUB>

Intervals

For statistics with Intervals, pay special attention to the interval you are using and replace currentperiod or CurrentPeriod in your path where needed. The possible values for Marquee
3.0 are currentperiod, currentshift, previousperiod, and previousshift. The possible values for Marquee 4.0 are CurrentPeriod, CurrentShift, PreviousPeriod, and PreviousShift.

Statistic with XPath and Manifest Configuration
Interval

Average Talk Time | Marquee 3.0 XPath:/page/workgroups/workgroup/queue/currentperiod/averagetalktime

Marquee 4.0 XPath:/Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/
ININ.Queue_Interval[@name="CurrentPeriod"]/ININ.Workgroup_AverageTalk Time

Manifest:ININ.Workgroup_AverageTalkTime?ININ.People.WorkgroupStats_Workgroup=
<SUB>&ININ.Queue_Interval=<ALL>

Average Wait Time | Marquee 3.0 XPath:/page/workgroups/workgroup/queue/currentperiod/averagewaittime

Marquee 4.0 XPath:/Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/
ININ.Queue_Interval[@name="CurrentPeriod"]/ININ.Workgroup_AverageWaitTime

Manifest:ININ.Workgroup_AverageWaitTime?ININ.People.WorkgroupStats_Workgroup=
<SUB>&ININ.Queue_Interval=<ALL>

Interactions Marquee 3.0 XPath:/page/workgroups/workgroup/queue/currentperiod/numberanswered

Al
Lehete Marquee 4.0 XPath:/Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/

ININ.Queue_Interval[@name="CurrentPeriod"]/ININ.Workgroup_InteractionsAnswered

Manifest:ININ.Workgroup_InteractionsAnswered?ININ.People.WorkgroupStats_Workgroup=
<SUB>&ININ.Queue_Interval=<ALL>

Interactions Marquee 3.0 XPath:/page/workgroups/workgroup/queue/currentperiod/numbercompleted

Completed Marquee 4.0 XPath:/Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/

ININ.Queue_Interval[@name="CurrentPeriod"]/ININ.Workgroup_InteractionsCompleted

Manifest:ININ.Workgroup_InteractionsCompleted?ININ.People.WorkgroupStats_Workgroup=
<SUB>&ININ.Queue_Interval=<ALL>

Interactions Entered | Marquee 3.0 XPath:/page/workgroups/workgroup/queue/currentperiod/numberofcalls
Marquee 4.0 XPath:

/Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/
ININ.Queue_Interval[@name="CurrentPeriod"]/ININ.Workgroup_InteractionsEntered

Manifest:ININ.Workgroup_InteractionsEntered?ININ.People.WorkgroupStats_Workgroup=
<SUB>&ININ.Queue_Interval=<ALL>

Interactions Marquee 3.0 XPath:/page/workgroups/workgroup/queue/currentperiod/numberabandoned

Al
bandoned Marquee 4.0 XPath:/Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/

ININ.Queue_Interval[@name="CurrentPeriod"]/ININ.Workgroup_InteractionsAbandoned

Manifest:ININ.Workgroup_InteractionsAbandoned?ININ.People.WorkgroupStats_Workgroup=
<SUB>&ININ.Queue_Interval=<ALL>

Service Level and Abandoned Rate for a legacy package

Service level and abandoned rate changed significantly from version 3.0 to 4.0. No exact comparison between the two exists. In order to make it possible for the values to be displayed
similar to the way they were displayed in 3.0, we've changed the key from the old values (1, 2, 3, and so on) to the new values available in the Accumulative Histogram parameter (10, 20,
30, and so on).

To include either of these statistics in the output when creating a legacy package, use ININ.Queues_InteractionType=Call and include one of the other workgroup queue parameters
using the desired Interval (i.e. CurrentPeriod) to generate the XPath /page/workgroups/workgroup/queue/<periodname> in the output. Here is a list of all the workgroup queue
parameters that may be included in the manifest to allow the service level and abandoned rate statistics to be generated:

e ININ.Workgroup_AverageTalkTime
e ININ.Workgroup_AverageWaitTime

44



o ININ.Workgroup_InteractionsAnswered
o ININ.Workgroup_InteractionsCompleted
e ININ.Workgroup_InteractionsEntered

o ININ.Workgroup_InteractionsAbandoned

When including one of these statistics with service level or abandoned rate, make sure to use all the same intervals. <ALL> can be used for the intervals of these statistics, but you
must specify the exact interval for service level and abandoned rate. For example, if you want the total service level for the PreviousPeriod, you would use these two lines in the
manifest:

® ININ.Workgroup ServicelLevelDistribution?ININ.People.WorkgroupStats_ Workgroup=<SUB>
&ININ.Queues_ InteractionType=Call&ININ.Queue Interval=PreviousPeriod
&ININ.Queue_ AccumulativeHistogramInterval=total

® ININ.Workgroup AverageTalkTime?ININ.People.WorkgroupStats_Workgroup=<SUB>&ININ.Queue_ Interval=PreviousPeriod

The default values in 3.0 were closer to the ININ.Queue PartialSumHistogramInterval parameter. However, because this parameter is not yet supported, you must use what is
available in the ININ.Queue AccumulativeHistogramInterval parameter.

Service Level

Marquee 3.0 XPath:

/page
/workgroups
/workgroup
/queue
/currentperiod
/servicelevels
/servicelevel
/value

Marquee 4.0 XPath:

/Statistics
/IcServer
/ININ.Workgroup
/ININ.People.WorkgroupStats Workgroup
/ININ.QueuesglnteractionType
/ININ.Queue Interval[@name="CurrentPeriod"]
/ININ.Queue AccumulativeHistogramInterval
/ININ.Workgroup_ServiceLevelDistribution

Manifest Parameters:

ININ.People.WorkgroupStats_Workgroup=<SUB>
ININ.Queues_InteractionType=<**A|[**>
ININ.Queues_InteractionType=Call
ININ.Queues_InteractionType=Chat
ININ.Queues_InteractionType=Generic
ININ.Queue_Interval=CurrentPeriod
ININ.Queue_Interval=CurrentShift
ININ.Queue_Interval=PreviousPeriod
ININ.Queue_Interval=PreviousShift

There are many values for ININ.Queue_AccumulativeHistograminterval. See your sample manifest to get the correct combinations based on your system and its modification. In
general, it works this way. When ININ.Queues InteractionType=<**All**>:

ININ.Queue_AccumulativeHistogramlinterval=0
ININ.Queue_AccumulativeHistograminterval=1
ININ.Queue_AccumulativeHistograminterval=2
ININ.Queue_AccumulativeHistograminterval=3
ININ.Queue_AccumulativeHistograminterval=4
ININ.Queue_AccumulativeHistograminterval=5
ININ.Queue_AccumulativeHistograminterval=6
ININ.Queue_AccumulativeHistograminterval=7
ININ.Queue_AccumulativeHistograminterval=8
Otherwise:
ININ.Queue_AccumulativeHistograminterval=10
ININ.Queue_AccumulativeHistograminterval=120
ININ.Queue_AccumulativeHistogramlInterval=20
ININ.Queue_AccumulativeHistograminterval=240
ININ.Queue_AccumulativeHistograminterval=30
ININ.Queue_AccumulativeHistograminterval=45
ININ.Queue_AccumulativeHistograminterval=60
ININ.Queue_AccumulativeHistograminterval=90

ININ.Queue_AccumulativeHistograminterval=total

Sample:

45



ININ.Workgroup ServiceLevelDistribution?ININ.People.WorkgroupStats Workgroup=<SUB>&IN
IN.Queues_ InteractionType=<**Al1**>&ININ.Queue Interval=CurrentPeriod&ININ.Queue Accu
mulativeHistogramInterval=8
Abandoned | Marquee 3.0 XPath:
Rate .
/page/workgroups/workgroup/queue/currentperiod/abandoneds/
abandoned/value
Marquee 4.0 XPath:
/Statistics/IcServer/ININ.Workgroup/
ININ.People.WorkgroupStats Workgroup/ININ.Queues InteractionType/ININ.Queue Interval
[@name="CurrentPeriod"]/ININ.Queue_ AccumulativeHistogramInterval
/ININ.Workgroup AbandonedRateDistribution
Manifest Parameters:
These parameters work the same as service level parameters. See "Manifest Parameters" under "Service Level" for more information
Sample:

ININ.Workgroup AbandonedRateDistribution?ININ.People.WorkgroupStats Workgroup=<sSUB>
&ININ.Queues_InteractionType=<**Al1l**>&ININ.Queue_Interval=CurrentPeriod&ININ.Queue_
AccumulativeHistogramInterval=8

Number of Agents in Status | Marquee 3.0 XPath:
/page/workgroups/workgroup/agentstatus/status/value
Marquee 4.0 XPath:

/Statistics/IcServer/ININ.Workgroup/ININ.People.WorkgroupStats_Workgroup/ININ.People Stat
us/ININ.Workgroup AgentsInStatus

Manifest Parameters:

ININ.Workgroup AgentsInStatus?ININ.People.WorkgroupStats Workgroup=
<SUB>&ININ.People_ Status=<ALL>

Agent Statistics

Because the new format and old format for XML output are not compatible, include a statistic with the same workgroup from a statistic not in this category. For example, if you add the
“Logged In” statistic from the “Support” workgroup, then also add another statistic from that workgroup, such as “Total Agents”. In that case you would have two statistics in your
manifest:

o ININ.IceLib.People.UserStatus_LoggedIn?ININ.IceLib.People.UserStatus_Workgroup=Support&NIN.IceLib.People.UserStatus_Userld=<ALL>

e ININ.Workgroup_AgentsLoggedIn?ININ.People.WorkgroupStats_Workgroup=Support

Statistic XPath and Manifest Configuration

Name Marquee 3.0 XPath: /page/workgroups/workgroup/agentstats/agent/name

Marquee 4.0 XPath: Statistics/IcServer/ININ.IceLib.People/ININ.IceLib.People.UserStatus_Workgroup/
ININ.IceLib.People.UserStatus_Userld/@name

Current Status Marquee 3.0 XPath: /page/workgroups/workgroup/agentstats/agent/currentstatus

Marquee 4.0 XPath: /Statistics/IcServer/ININ.IceLib.People/ININ.IceLib.People.UserStatus_Workgroup/
ININ.IceLib.People.UserStatus_Userld/ININ.IceLib.People.StatusMessageDetails_MessageText

Manifest: ININ.IceLib.People.StatusMessageDetails_MessageText?ININ.IceLib.People.UserStatus_Workgroup=
<SUB>&ININ.IceLib.People.UserStatus_Userld=<ALL>

Current Status Key | Marquee 3.0 XPath: /page/workgroups/workgroup/agentstats/agent/currentstatuskey

Marquee 4.0 XPath: /Statistics/IcServer/ININ.IceLib.People/ININ.IceLib.People.UserStatus_Workgroup/
ININ.IceLib.People.UserStatus_Userld/ININ.IceLib.People.StatusMessageDetails_Id

Manifest: ININ.IceLib.People.StatusMessageDetails_Id?ININ.IceLib.People.UserStatus_Workgroup=
<SUB>&ININ.IceLib.People.UserStatus_Userld=<ALL>

Time in Status Marquee 3.0 XPath: (in seconds): /page/workgroups/workgroup/agentstats/agent/timeinstatus

Marquee 4.0 XPath (time the status began): /Statistics/IcServer/ININ.IceLib.People/ININ.IceLib.People.UserStatus_Workgroup/
ININ.IceLib.People.UserStatus_Userld/ININ.IceLib.People.UserStatus_StatusChanged

Manifest: ININ.IceLib.People.UserStatus_StatusChanged?ININ.IceLib.People.UserStatus_Workgroup=
<SUB>&ININ.IceLib.People.UserStatus_Userld=<ALL>

On Phone Marquee 3.0 XPath: /page/workgroups/workgroup/agentstats/agent/onphone

Marquee 4.0 XPath: /Statistics/IcServer/ININ.IceLib.People/ININ.IceLib.People.UserStatus_Workgroup/
ININ.IceLib.People.UserStatus_Userld/ININ.IceLib.People.UserStatus_OnPhone

Manifest: ININ.IceLib.People.UserStatus_OnPhone?ININ.IceLib.People.UserStatus_Workgroup=
<SUB>&ININ.IceLib.People.UserStatus_Userld=<ALL>

Logged In Marquee 3.0 XPath: /page/workgroups/workgroup/agentstats/agent/loggedin

Marquee 4.0 XPath: Statistics/IcServer/ININ.IceLib.People/ININ.IceLib.People.UserStatus_Workgroup/
ININ.IceLib.People.UserStatus_Userld/ININ.IceLib.People.UserStatus_Loggedin

Manifest: ININ.IceLib.People.UserStatus_LoggedIn?ININ.IceLib.People.UserStatus_Workgroup=
<SUB>&ININ.IceLib.People.UserStatus_Userld=<ALL>
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Retrieve raw JSON and XML statistical data from the Marquee web service

In Interaction Marquee 4.0 SU5, use the web service to retrieve raw statistical data in XML or JSON by adding a request to your custom code. See the following example:
e Example: XML
e Example: JSON

Example: XML

This example displays a request for data in XML, and the resulting response.
Datarequest

GEThttp://iwpclayweb1.app.inin.com:8070/GetPackageData?id=c02881d8-49d0-4086-a083-dbc113ceeebbHTTP/1.1
Accept: text/html,application/xhtml+xml,application/xml;q=0.9,*/*;q=0.8

Data Response

HTTP/1.1 200 OK
Content-Type: application/xml

<?xml version="1.0" encoding="utf-8"?>

<Statistics>

<lcServer name="Iwpclayic1">

<ININ.Workgroup>
<ININ.Workgroup_NumberAvailableForACDInteractions>9</ININ.Workgroup_NumberAvailableForACDInteractions>
</ININ.People.WorkgroupStats_Workgroup>
</ININ.Workgroup>

</IlcServer>

<PackageName>aaa</PackageName>
<Description></Description>
<Created>20130711T152049914Z</Created>
<Message></Message>
<MessageExpires>20130711T200621142Z</MessageExpires>
</Statistics>

Example: JSON

This example displays a request for data in JSON, and the resulting response.

Datarequest

GEThttp://iwpclayweb1.app.inin.com:8070/GetPackageData?id=c02881d8-49d0-4086-a083-dbc113ceeebbHTTP/1.1
Accept: application/json,text/html,application/xhtml+xml,application/xml;q=0.9,*/*;q=0.8

Data Response

HTTP/1.1 200 OK
Content-Type: application/json
"Statistics":
"IcServer":{
"name" : "Iwpclayicl",
"ININ.Workgroup": {
"ININ. People.WorkgroupStats_Workgroup": {
"name" : "workgroupl",
"ININ.Workgroup NumberAvailableForACDInteractions":"9"
}
}
b
"PackageName": "aaa",

"Description":"",
"Created":"20130711T165114783z",
"Message":"",

"MessageExpires":"20130711T200621142z2"
}
}

>>>> ORIGINAL //eic/2021r1_systest/products/documentation/source/Technical_Reference_HTML/web_portal_marquee_icg/Example_JSON.htm#1 ==== THEIRS
/leic/2021r1_systest/products/documentation/source/Technical_Reference_ HTML/web_portal_marquee_icg/Example_JSON.htm#2

Note: To locate the GUID for the JSON request, you need to run SharpDap Edit. Which is located on the Marquee Server (C:\Program Files (x86)\Interactive Intelligence\Interaction Web
Portal\common). From the File menu, choose Connect and fill out the details to connect to the server. Select the desired package to retrieve data and paste in
the ObjectGUID. Replace >>>> ORIGINAL
//eic/2021r1_systest/products/documentation/source/Technical_Reference_HTML/web_portal_marquee_icg/Example_JSON.htm#2
ashttp://yourMarqueeServer:8070/GetPackageData?id=0bjectGUID

==== THEIRS //eic/2021r1_systest/products/documentation/source/Technical_Reference_HTML/web_portal_marquee_icg/Example_JSON.htm#3 as

http://yourMarqueeServer:8070/GetPackageData?id=ObjectGUID ==== YOURS //inf-
5cd0246xjc_eic_main_systest/products/documentation/source/Technical_Reference_HTML/web_portal_marquee_icg/Example_JSON.htm

ashttp://yourMarqueeServer:8070/GetPackageData?id=0bjectGUID ==== YOURS //inf-
5cd0246xjc_eic_main_systest/products/documentation/source/Technical_Reference_HTML/web_portal_marquee_icg/Example_JSON.htm

Note: To locate the GUID for the JSON request, you need to run SharpDap Edit. Which is located on the Marquee Server (C:\Program Files (x86)\Interactive Intelligence\Interaction Web
Portal\common). From the File menu, Select Connect and enter the details to connect to the server. Select the desired package to retrieve data and paste in the ObjectGUID. Replace
as httpr//yourMarqueeServer:8070/GetPackageData?id=ObjectGUID

<LK <L
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http://iwpclayweb1.app.inin.com:8070/GetPackageData?id=c02881d8-49d0-4086-a083-dbc113ceeebb
http://yourmarqueeserver:8070/GetPackageData?id=ObjectGUID
http://yourmarqueeserver:8070/GetPackageData?id=ObjectGUID
http://yourmarqueeserver:8070/GetPackageData?id=ObjectGUID
http://yourmarqueeserver:8070/GetPackageData?id=ObjectGUID

Appendix A: Best practice and other Interaction Web
Portal tips

This section describes best practice recommendations that, while not required, are proven techniques offered to improve standard
operating procedures and help enhance Interaction Web Portal behavior.

Best practice recommendations include:
Set up an HTTP to HTTPS redirect for Interaction Web Portal

Set up an HTTP to HTTPS redirect for Interaction Web Portal

You can configure Interaction Web Portal to redirect from HTTP, which sends data as plain text, to HTTPS, which encrypts the data
sent and received with SSL. Configuring a redirect can improve the user experience.

You may receive HTTP Error 403.4 — Forbidden. The page that you are trying to access is secured with Secure Sockets Layer (SSL)
when you try to browse to http://mydomain.com/iwp.

To configure automatic redirection from HTTP to HTTPS
1. From the Start menu, select Control Panel > Administrative Tools > Internet Information Services (11S) Manager.
In the Connections area, click the + to expand the computer name, then click the + to expand the Sites node.
Click the website to which Interaction Web Portal is installed.
Select Features View at the bottom of the window.
Double-click HTTP Redirect. Or right-click HTTP Redirect and click Open Feature.
Click to select the Redirect requests to this destination check box, and then type the absolute Interaction Web Portal URL.

For example, https://mydomain.com/iwp.
7. Inthe Redirect Behavior section, click to select the Only redirect requests to content in this directory (not subdirectories)
check box.

8. Inthe Status code list, select Found (302).
9. Click Apply to save the settings.
10. Run the IISRESET command to put the settings into effect.

ook wDd

48


http://mydomain.com/iwp
https://mydomain.com/iwp

Appendix B:Set up TCP Ports for Interaction Web Portal

Configure specific Interaction Web Portal TCP ports in your firewall to allow the IWP Web Server to communicate to the database
and the CIC server.Specify these ports to access all IWP features, for example, reporting purposes, recording access, and
questionnaire scoring analysis.

Typically, the TCP ports are entered after an administrator establishes a Data Management Zone (DMZ) configuration behind the
network firewall.Where and how the ports are entered depend on the firewall.

The following table lists the TCP ports and how they are used for IWP:

Port Protocol | Use

3952 TCP Session Manager PureConnect port for client connections to the CIC server.

389 or 636(TLS/SSL) | TCP LDAP or LDAPS - Lightweight Directory Services is used to store IWP configuration.
445 TCP Microsoft-ds Copying recordings from the CIC server to the media folder for streaming.
1433 TCP Ms-sql-s Scheduled reports access.

8106 (lIRC) TCP Provides access to recordings from the CIC server or remote content server.

8070 TCP Interaction Marquee package data updates.
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Appendix C: Scheduled Reports

Interaction Scheduled Reports is required in order to use the Reports Access in IWP. Once reports are created in Interaction
Scheduled Reports, you can select which reports are available for use, and then specify when and how often a report is run. IWP
uses reports defined in Interaction Administrator and configured in Interaction Scheduled Reports.
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This appendix includes:

e View reports in Interaction Web Portal
e Set up IWP for Scheduled Reports

View reports in Interaction Web Portal

In IWP, you can view recent reports, upcoming reports and available reports, which can be run manually. Administrators can view
and download any recently run report.
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You can also access predefined reports and set such delivery options as run time and frequency needed through a reporting wizard,
as shown in the following dialog boxes.

This section includes:

e View report details

o Specify the report destination
e Specify the report frequenc
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View report details

Review the name, category, description, start and run dates, and the predefined parameters set for the selected report.

DateTims  DATETIME O0u00:00-2):5M59

Sreld MUMBER O-950

Specify the report destination

Select email recipients, the format in which you want the report output to be delivered, file locations, and whether or not to
overwrite previously run versions of the report.
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Specify the report frequency

Determine how often you want the report to run, and what time you want to run it.

Specify Report Frequency
Heurly Call Susnemary by Extendgssn
O One ma @ Weekhy T Monthy

Day{s) of the wesk to run the report:

[ sunday ¥ Monday ¥ Tuesday ¥ Wadnesday
¥ Thursday WiFrday £ saturday

{1200 Pt |

Set up IWP for Scheduled Reports

Before you can begin using Scheduled Reports, you must first configure IWP to use this feature. In this section:

e Create a directory share in which to store reports

Install the Scheduled Reports Client installation files

Install the Scheduled Reports Monitoring Server (SRMS)

Verify the Custom Passthrough Log is active

Configure the Scheduled Reports installation

Assign the appropriate security right to IWP's administrative user

Create a directory share in which to store reports

Create a directory share on the CIC Server to which Scheduled Reports can store reports. This will allow you to access reports and
set permissions, as well as view and manage open files and users connected to the share. You can create the share in any location
suitable to your company requirements.
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Install the Scheduled Reports Client installation files

The CIC Scheduled Reports installs and related files are available to install from the PureConnect Customer Interaction Center (CIC)
.iso file. The install is located under \Installs\Off-ServerComponents.

1.

If you have not done so already:
a. Download the CIC 2015 R1 or later .iso file from the Product Downloads page at

https://help.genesys.com/pureconnect/secure/Downloads.aspx

b. Copy the .iso file to a file server (non-IC server) with a high bandwidth connection to the server(s) on which you will be
running the CIC installs.

c. Mount the .iso file and share the contents to make them accessible to the server(s) on which you will be running the CIC
installs.

Navigate to the \Installs\Off-ServerComponents directory on the file server.

Copy the Scheduled Reports .msi for 2015 R2 or later file to the 64-bit Windows Server server operating system machine on
which you plan to run this install.

Install the Scheduled Reports Monitoring Server (SRMS)

The main function of the Scheduled Reports Monitoring Service is to send notifications to the CIC Handlers when a scheduled
report is ready to run. It also monitors the Scheduled Reports Database tables on five-minute intervals for changes to current
scheduled reports.

Note: Before you install the Scheduled Reports Monitor Server application, first install Microsoft .NET Framework 4.7
or later. This installation is a requirement for monitoring servers running Scheduled Reports. For more information, see the

Scheduled Reports Installation and Configuration Guide located in the PureConnect Documentation Library.

To install the Scheduled Reports Monitor Server:

1.

ook WD

From the shared location, double-click ScheduledReportsServer.msi. The Scheduled Reports Monitor Server for CIC
Setup dialog opens.

Click Next. The Custom Setup dialog opens.

Optionally click the Scheduled Reports Monitor Server icon to access the custom installation features.
Optionally select the way features are installed by clicking the appropriate feature icon.

Click Next. The IC Server Name dialog opens.

In the IC Server Name field, enter the CIC server to which you want to connect.

Note:lf you have multiple CIC servers to which Scheduled Reports communicates, enter only one CIC server name now.
Additional CIC server names are defined with the PureConnect Scheduled Reports Configurator Tool later in the
implementation.

Click Next. The Ready to install Scheduled Reports Monitor Server dialog opens.

Click Install to begin the installation process. The Installing Scheduled Reports Monitor Serverdialog opens.It displays a
Status bar and messages as the installation progresses.

When the installation is complete, click Finish in the Completed the Scheduled Reports Monitor Server Setup Wizard.

The You Must Restart Your System dialog displays when a restart is required to finish the configuration changes made to
Scheduled Reports Monitor Server. Click Yes to restart your system.
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Verify the Custom Passthrough Log is active

An important post-installation task is required when the Scheduled Reports Monitor Server (SRMS) installation is complete.
The CIC and Scheduled Reports Administrator must verify that the Custom Passthrough Log is active.

Scheduled Reports handlers insert data into the SQL Server or Oracle database using the LoggingCustomPassthrough tool step.
Microsoft Message Queuing (MSMQ) lets users reliably send data to custom logging tables with the same reliability as CIC
data. Since this tool step is being used, Custom Passthough is required on the Customer Interaction Center (CIC) server.
To verify that the Custom Passthrough Log is active:

1. OpenInteraction Administrator.

2. Click the System Configuration node and then click the Report Logs container.

3. Double-click Custom Passthrough Log. The Report Log Configuration dialog opens.

4. Onthe Basic tab, ensure the Active check box is selected.

' Note:This dialog is the only location where Custom Passthrough is established for a CIC server. '

5. Click OK to save your changes and close the Custom Passthrough Log.

Configure the Scheduled Reports installation

Now you're ready to configure the Scheduled Reports configuration. This includes configuring the Scheduled Reports monitoring
service and working with the PureConnect Scheduled Reports Configurator Tool to set up the data repository. Here, you will:

e Complete CIC connection parameters for the server on the IC Connection tab
e Set up database connection parameters for the server on the DB (database) Connection tab

e Use the Error Notifications dialog to allow e-mail error notifications to be sent to the CICAdministrator and to create a
customized list of e-mail addresses for error notification

o Set file overwrite frequency values, valid time and interval settings, and available scheduling times for users when they generate
scheduled report on the scheduling tab

o Specify valid export formats, available printers, and report categories.An accessible file location must be configured to point to
the directory share specified earlier in the IWP scheduled reports configuration.

For detailed instructions, see the Scheduled Reports Installation and Configuration Guide located in the PureConnect
Documentation Library.

Assign the appropriate security right to IWP's administrative user

Ensure the IWP’s administrative user has the Interaction Reporter Administrator security right. For information on how to
assign security rights, see “Security Rights” in the /nteraction Administrator help.




Change log

Date Changes
26-August-2014 Updated documentation to reflect changes required in the transition from version 4.0 SU# to CIC 2015 R1,
such as updates to product version numbers, system requirements, installation procedures, references to
Interactive Intelligence Product Information site URLs, and copyright and trademark information.
19-January-2015 Updated documentation to include assigned licensing feature and clarify Interaction Marquee licensing.
07-October-2015 Added Appendix D to reflect installation and configuration of Scheduled Reports. Updated Microsoft .NET

Framework requirements. Also updated cover page for rebranding and most recent copyright and trademark
information.

07-December-2015

Moved Interaction Marquee from an appendix to a separate section in the document, called Work with
Interaction Marquee. Added a section in Work with Interaction Marquee to provide guidance regarding
memory, bandwidth, and CPU requirements. Replaced installation images to reflect company branding.

18-October-2016 Updated "Download and install 1IS Media Services" section to include new link and instructions for install.

03-May-2017 Updated "Install Interaction Web Portal" section and "Install the Scheduled Reports Monitoring Server"
section from .Net Framework 4.0 to 4.5.2 or later.

11-July-2017 Updated Microsoft .NET Framework 4.5.2 requirement to Microsoft .NET Framework 4.5.2 or later.

21-August-2017

Updated for rebranding. Updated references to IC, Interactive Intelligence, CIC, PureConnect. Updated title
page and copyright page.

07-September-2017

Added "Configure timeout values" section under post-installation tasks.

26-October-2017

Updated requirements to include Windows Server 2016.

08-November-2017

Updated "Introduction to Interaction Web Portal" section to indicate that Active Directory Lightweight
Directory Services, or AD LDS replicas, does not allow for high scalability and redundancy.

11-January-2018

e Conversionto HTML.
e Removed Windows Server 2008 R2 as a requirement for 2018 R3.

14-February-2018 Updated Requirements and Post-installation tasks sections to include note about installing Desktop
Experience feature during Windows Server 2016 install.

04-May-2018 Updated for .NET Framework 4.7. Replaced .NET Framework requirements with link to Software
Requirements page.
Updated procedures for Windows Server 2012 R2 and 2016 in Enable and configure lIS and IIS Medias Services

10-May-2018 S —

25-September-2018 Updated Install Silverlight 5.0 and Configure CIC servers to use IWP under Portal Management IC System

procedure to include tip for User credentials (LDAP and IC server credentials).

01-October-2018

Updated link to install IS Media Services in Web server requirements section.

Updated KB link in Download and install IS Media Services section.

04-October-2018
16-Julv-2019 Reorganized the content only, which included combining some topics and deleting others that just had an
ALkl introductory sentence such as, "In this section...".
Changed ".NET Framework 4.5 Features" to ."NET Framework 4.6 Features" in Step 5 of the Windows Server
05-August-2019

2016 section of Activate Windows Communication Foundation (WCF) topic.

01-October-2019

Updated link to Microsoft IIS Media Services install in Download and install IS Media Services topic.

05-November-2019

Updated KB link in Download and install IS Media Services topic.

11-November-2019

In Download and install IS Media Services topic, updated KB link and added link to use CIC Utilities and
Downloads to access zip file.

19-November-2019

Updated "Install Silverlight 5.0 and Configure CIC servers to use IWP under Portal Management IC System
Configuration" topic to note in step 10 that each CIC server pair can have only one IWP connection.

03-March-2020

Updated requirements to include Windows Server 2019.
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30-April-2020

Updated links from my.inin.com to new locations.

19-May-2020

Added Configure Security for Interaction Web Portal topic.
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